Integrating Office 2003 Applications and the World Wide Web 

CASE PERSPECTIVE 

Leland Mortgage is a mortgage broker for properties 

in several communities in Ohio. Loan agents find the 

right loans for borrowers, including borrowers who 

have income or credit difficulties. Lian Chang manages 

Leland Mortgage. In the past, the company enjoyed 

great success by being the only mortgage company in 

the area. Recently, the company’s clientele has been 

using newer services, such as Internet-based mortgage 

companies and other local financial service providers. 

Lian believes that the company’s business would 

increase if she implements a marketing strategy that 

advertises the advantages Leland Mortgage has over 

competitors’ services. Leland Mortgage offers nationally 

competitive interest rates and a simplified application 

process. In addition, Lian employs highly trained 

loan agents and a friendly staff. She is investigating 

ways to advertise these benefits in an efficient and 

cost-effective way. She thinks a Web site would be the 

answer, but she is inexperienced with the Internet. 

Lian knows that you are studying computer technology 

and asks you to help her create a Web site 

advertising Leland Mortgage. 

Lian provides you with several files to get started, 

including the company’s letterhead in a Word document, 

an Excel workbook that includes a chart, an 

Access database of the company’s mortgage products, 

and a PowerPoint presentation that provides an 

overview of the company’s mortgage application 

process. Using the information provided in these files, 

you are confident that you can create a compelling 

Web page that highlight’s the company’s strengths. 

As you read through this project, you will learn 

how to use Office 2003 applications together to 

create a Web page. 

P R O J E C T

Introduction 

Integration means joining parts so they work together or form a whole. In 

information technology, common usages can include the following: 

1. Integration during product development combines activities, programs, or 

hardware components into a functional unit. 

2. Integration in companies can bring different manufacturers’ products 

together into an efficiently working system. 

3. Integration in marketing combines products or components to meet 

objectives such as sharing a common purpose or creating demand. It includes 

such matters as consistent product pricing and packaging, advertising, and 

sales campaigns. 

4. Integration in product design allows a unifying purpose and/or architecture, 

such as The Microsoft Office System. (The products also are sold 

individually, but they are designed with the same larger objectives 

and/or architecture.) 

This Integration project will show you how you can use the functionality and 

productivity tools of the Microsoft Office System. 
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You will have mastered the material in this project when you can: 

Integrate the Office 2003 applications to create a 

Web site 

Add hyperlinks to a Word document 

Embed an Excel chart into a Word document 

Add scrolling text to a Web page created in 

Word 

Add a hyperlink to a PowerPoint slide 

Create Web pages from a PowerPoint 

presentation 

Create a data access page from an Access 

database 

Test a Web site in a browser 

O b j e c t i v e s 

P R O J E C T

Integration Project — Leland Mortgage Web Site 

Many businesses advertise their products and services on the Internet. Companies 

find it easy to create Web pages using information already saved in word processing, 

spreadsheet, database, or presentation software formats. The Web page creation capabilities 

of Microsoft Office 2003 make it simple for you to create an entire Web site 

using the information available. Word allows you to create and save a document as a 

Web page. PowerPoint provides the same capability and adds a navigation structure 

for browsing. In addition, an Access wizard helps you create data access pages that 

enable the Web page visitor to navigate through the database. 

This project supplies the following four files of information to help you get 

started: 

1. A Word document that contains the company letterhead, including logo 

images, company name, and company address (Figure 1-1a on page INT 6). 

2. An Excel workbook with a Bar chart graphically illustrating the company’s 

breakdown of mortgage type by mortgage amount (Figure 1-1b on page 

INT 6). 

3. A PowerPoint slide show that contains general information about the 

company (Figure 1-1g on page INT 7). 

4. An Access database that contains mortgage product information (Figure 1-1c 

on page INT 6). 

The Leland Mortgage Web site should include the following: 

1. A home page with a Bar chart that contains the mortgage type by mortgage 

amount (Figure 1-1e on page INT 7). Three hypertext links also are included 

on the home page: Application Process, Mortgage Products, and E-mail for 

Information. 

2. The Mortgage Products data access page (Figure 1-1d on page INT 6) is 

created from the Access file. Clicking the Mortgage Products link on the 

home page accesses this Web page. On this Web page, visitors can scroll 

through the mortgage products, categorized by mortgage type. 

3. The PowerPoint Web page (Figure 1-1g on page INT 7) displays information 

about the company’s simplified application process. Clicking the Application 

Process link on the home page accesses this Web page. 

4. Using the E-mail for Information hyperlink, you can create an e-mail message 

(Figure 1-1f on page INT 7). E-mail is sent to the e-mail address 

manager@isp.com. 

The following pages contain a detailed explanation of these tasks. 
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FIGURE 1-1 

logo 

images 

heading 

(a) Word Document 

(b) Bar Chart in Excel 

(c) Access Table 

(d) Data Access Page 

Mortgage Products 

group level
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(e) Word Document Saved as Web Page 

(f) New E-Mail Message Created from Hyperlink 

(g) PowerPoint Presentation Saved as Web Page

Adding Hyperlinks to a Word Document 

The Web site created for Leland Mortgage consists of an initial Web page, called the 

home page, with two hyperlinks to other Web pages, an e-mail link, and a Bar 

chart. Clicking a hyperlink, which can be text or an image, allows you to jump 

to another location. Text is used (Application Process, Mortgage Products, E-mail 

for Information) for the three hyperlinks on the Leland Mortgage home page 

(Figure 1-1e on the previous page). The first hyperlink (Application Process) jumps 

to a PowerPoint Web page that contains three Web pages that explain the mortgage 

application process. A second hyperlink (Mortgage Products) jumps to a data access 

page that provides inquiry capabilities for customers to access Leland Mortgage’s 

mortgage product database. This Web page allows inquiries only; updating the database 

is prohibited. The third hyperlink (E-mail for Information) creates an e-mail 

message. In order to place the three hyperlinks to the left of the Bar chart, a table 

will be created in the Word document. 

Starting Word and Opening a Document 

The first step in this project is to open the Word document, Leland Mortgage 

Letterhead, and save it with the new file name, Leland Mortgage Home Page. 

To Start Word, Customize Word, Open an Existing 

Document, and Save the Document with Another Name 

Insert the Integration Data Disk in drive A. See page xxiv at the front of this 

book for instructions for downloading the Data Disk or see your instructor 

for information on accessing the files required in this book. 

Click the Start button on the Windows taskbar, point to All Programs on 

the Start menu, and then click Open Office Document on the All Programs 

submenu. 

Click the Look in box arrow and then click 31/2 Floppy (A:) in the Look in list. 

Double-click Leland Mortgage Letterhead. 

If the Languag0000e bar is displayed, right-click it and then click Close the 

Language bar on the shortcut menu. 

If the Getting Started task pane appears in the Word window, click its Close 

button in the upper-right corner. 

If the Standard and Formatting toolbars are positioned on the same row, 

click the Toolbar Options button and then click Show Buttons on Two Rows. 

Click File on the menu bar and then click Save As. Type Leland Mortgage 

Home Page in the File name text box and then click the Save button in the 

Save As dialog box. 

The document is saved as Leland Mortgage Home Page (Figure 1-2). 
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Web Pages 

Making information available 

on the Internet is a key 

aspect of business today. To 

facilitate this trend, the Office 

2003 applications easily allow 

you to generate Web pages 

from existing files. An entire 

Web site can be created with 

files from Word, Excel, 

PowerPoint, or Access, using 

the Save as Web Page 

command on the File menu. 

More About

FIGURE 1-2 

Inserting a Table into a Word Document 

The next step is to insert a table with two columns and one row. The left column 

will contain three hyperlinks. The right column will contain the Bar chart. 

The following steps add a table to the Leland Mortgage Home Page document. 

To Insert a Table into a Word Document 

• Position the insertion point on 

the second paragraph mark below 

the company telephone number. 

• Click Table on the menu bar, point 

to Insert, and then click Table. 

Word displays the Insert Table dialog box 

(Figure 1-3). 

FIGURE 1-3 
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logo 
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title bar displays 

new file name 
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Home Page button 

on taskbar 

heading 
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Tables 

You can use tables to 

create page layouts, such as 

side-by-side paragraphs, or to 

create text, graphics, and 

nested tables on a Web page. 

Tables are used frequently in 

Web pages to structure 

information and images. 

More About

• Type 2 in the Number of columns 

box and then press the TAB key. 

• Type 1 in the Number of rows box 

and then click AutoFit to contents 

in the AutoFit behavior area. 

The new settings appear in the Insert Table 

dialog box (Figure 1-4). 

FIGURE 1-4 

• Click the OK button. 

Word displays the table in the document 

(Figure 1-5). 

FIGURE 1-5 

Step 2 instructed you to select AutoFit to contents. The AutoFit to contents 

option allows you to make the columns in a table fit the contents automatically. If 

you do not select AutoFit to contents, you can adjust the column widths manually 

using the sizing handles. 

Eliminating the Table Border 

The two-column, one-row table has been inserted into the Word document. The 

table border is not necessary for the Web page. The next steps remove the border of 

the table. 
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1. Click Insert Table button 

on Standard toolbar, drag 

through one row and two 

columns, click mouse 

button 

2. In Voice Command mode 

say, “Insert Table,” [drag 

through one row and two 

columns, click mouse 

button] 

Other Ways 
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in table 
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in table 
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AutoFit to contents 

option button 

selected 

OK button

To Remove the Table Border 

• Click Table on the menu bar and 

then click Table Properties. 

• Click the Borders and Shading 

button in the Table sheet. 

• When the Borders and Shading 

dialog box displays, if necessary, 

click the Borders tab. 

Word displays the Borders and Shading dialog 

box (Figure 1-6). 

FIGURE 1-6 

• Click the None button in the 

Setting area and then click the OK 

button in the Borders and Shading 

dialog box. 

• Click the OK button in the Table 

Properties dialog box. 

Word displays the borderless table 

(Figure 1-7). 

FIGURE 1-7 

The border of the table displays with gridlines in the Word document. Gridlines 

can be used as a guide when entering text or images. When the document is viewed 

in your browser or printed, the gridlines do not display or print. 

Inserting the Text for the Hyperlinks 

After creating the borderless table, you must insert the three text phrases that 

will be used as hyperlinks on the home page. These phrases (Application Process, 

Mortgage Products, and E-mail for Information) allow the Web page visitor to jump 

to two other Web pages and create an e-mail message. The steps on the next page 

add the text phrases that are used as hyperlinks. 
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Borders and 

Shading dialog box 

Borders 

tab 

None 

button 

OK button 

gridlines in 

table 

Hyperlinks 

In addition to the way in 

which the hyperlinks are 

created in this project, you 

can copy and paste text as a 

hyperlink. Copy the text you 

want to the Clipboard, click 

where you want to insert the 

text, and then click Paste as 

Hyperlink on the Edit menu. 

More About

To Insert Text for Hyperlinks 

• If necessary, click the leftmost cell 

in the table. 

• Type Application Process and 

then press the ENTER key twice. 

• Type Mortgage Products and 

then press the ENTER key twice. 

• Type E-mail for Information 

but do not press the ENTER key. 

Word displays the table with the three text 

phrases that will be used as hyperlinks 

(Figure 1-8). 

FIGURE 1-8 

With the text phrases added, the next step is to select each text phrase and then 

insert the corresponding hyperlink. 

Inserting a Hyperlink to PowerPoint Web Pages 

The Insert Hyperlink feature provides the capability of linking to an existing file 

or Web page, to a place within the current document, to a newly created document, 

or to an e-mail address. In this project, two hyperlinks (Application Process and 

Mortgage Products) will be created that link to Web pages. The Application Process 

hyperlink will jump to a PowerPoint presentation that is saved as a Web page using 

the Web page name ApplicationProcess.htm. The Mortgage Products hyperlink will 

jump to a data access page using the Web page name MortgageProducts.htm. You 

will create the data access page later from an existing Access database. The third text 

phrase (E-mail for Information) links to an e-mail address, allowing the Web page 

visitor to send an e-mail message to the company’s manager. 

The following steps create a hyperlink for the first text phrase. 
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button 

right-hand 
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Mortgage Products 

text for hyperlink 

Application Process 

text for hyperlink 

E-mail for Information 

text for hyperlink 

Q: Can hyperlinks link to 

both external and internal 

locations within the current 

document? 

A: Yes. Hyperlinks can link 

to both external and internal 

locations within the current 

document. To link to a location 

inside the current document, 

select the Place in This 

Document option in the Link 

to bar in the Insert Hyperlink 

dialog box. The Microsoft 

Office 2003 application then 

will provide a list of locations 

within the current document 

to which you can link. 

& Q A

To Create a Hyperlink to PowerPoint Web Pages 

• Drag through the text, 

Application Process, in the table. 

• Click the Insert Hyperlink button 

on the Standard toolbar. 

• If necessary, click the 

Existing File or Web Page 

button on the Link to bar. 

• Type ApplicationProcess.htm 

in the Address text box. 

The Insert Hyperlink dialog box 

is displayed with the name of 

the Web page in the Address 

text box (Figure 1-9). 

• Click the OK button. 

FIGURE 1-9 

The hyperlink is assigned to the Application Process text phrase. After the Word 

document is saved as a Web page and the visitor clicks the text, Application Process, 

the ApplicationProcess.htm file on drive A is displayed. The following steps add the 

other two hyperlinks. 

To Insert the Remaining Hyperlinks 

Drag through the text, Mortgage Products, in the table. Click the Insert 

Hyperlink button on the Standard toolbar. 

Type MortgageProducts.htm in the Address text box and then click the OK 

button. 

Drag through the text, E-mail for Information. Click the Insert Hyperlink 

button on the Standard toolbar and then click the E-mail Address button on 

the Link to bar. 

Type manager@isp.com in the E-mail address text box. 

Type Mortgage Application in the Subject box and then click the OK 

button. 

Word displays the table as shown in Figure 1-10 on the next page. 
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button 
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1. On Insert menu click 

Hyperlink 

2. Right-click selected words, 

click Hyperlink on shortcut 

menu 

3. Press CTRL+K 

4. In Voice Command mode 

say, “Hyperlink” 

Other Ways

FIGURE 1-10 

The three hyperlinks are created. When you click the E-mail for Information 

hyperlink, it will create an e-mail message to manager@isp.com. The other two 

hyperlinks (Application Process and Mortgage Products) will not be functional until 

the corresponding Web pages are created later in this project. 

Embedding an Excel Chart into a Word Document 

This project uses the Object Linking and Embedding (OLE) feature of Microsoft 

Office 2003 to insert the Excel chart into a Word document. OLE allows you to 

incorporate parts of a document or entire documents from one application into 

another. The Bar chart in Excel is called a source object (Figure 1-1b on page 

INT 6) and the Leland Mortgage Home Page document is the destination 

document. After an object is embedded, it becomes part of the destination document. 

This project illustrates using the Paste Special command on the Edit menu to 

embed the Excel object. Paste Special inserts an object into Word, but still recognizes 

the source program, the program in which the object was created. When you 

double-click an embedded object, such as the Mortgage Amount by Mortgage Type 

worksheet, the source program opens and allows you to make changes. In this example, 

Excel is the source program. With the hyperlinks added to the Word document, 

the next step is to embed the Bar chart into the Word document. The following steps 

open the Excel workbook. 

To Start Excel, Customize Excel, and Open an Existing Workbook 

Click the Start button on the Windows taskbar, point to All Programs on 

the Start menu, and then click Open Office Document on the All Programs 

submenu. 

If necessary, click the Look in box arrow and then click 31/2 Floppy (A:) in the 

Look in list. 

Double-click the Leland Mortgage Product Types workbook. 

If the Language bar is displayed, right-click it and then click Close the 

Language bar on the shortcut menu. 

If the Getting Started task pane is displayed in the Excel window, click its Close 

button in the upper-right corner. If the Chart toolbar is displayed, click its Close 

button. 

If the Standard and Formatting toolbars are positioned on the same row, 

click the Toolbar Options button and then click Show Buttons on Two Rows. 

6

5

4

3

2

1 

INT 14 • Office Integration Project 1 • Integrating Office 2003 Applications and the World Wide Web 

Microsoft Office 

2003 Integration 

hyperlinks created, 

changing text to blue 

and underlined 

Embedded 

Objects 

The advantage of using an 

integrated set of applications, 

such as Office 2003, is the 

capability of sharing information 

among applications. The 

Object Linking and Embedding 

(OLE) features of Office 

2003 make the integration 

process more efficient. A 

chart created in Excel can be 

included in a Word document 

using OLE. To edit the 

embedded object, doubleclick 

it. The source program 

then starts and opens the 

source object for editing. 

More About

The next two sections explain how to embed an Excel chart into a Word document 

and then resize it. The first section explains embedding a chart into a Word document. 

The following steps embed the Excel Bar chart into the Word document. 

To Embed an Excel Chart into a Word Document 

• If necessary, click the Mortgage 

Amount Chart tab. 

The Bar chart is active and is displayed 

(Figure 1-11). 

FIGURE 1-11 

• Click the white area around the 

chart area to select the chart and 

then click the Copy button on the 

Standard toolbar. 

Excel places a copy of the Bar chart on the 

Office Clipboard. A moving border is displayed 

around the chart area (Figure 1-12). 

FIGURE 1-12 

• Click the Leland Mortgage Home 

Page button on the taskbar. 

• If necessary, click the right 

column of the table. 

• Click Edit on the menu bar. 

The Edit menu is displayed (Figure 1-13). 

FIGURE 1-13 
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Paste Special 

command 

Edit menu

• Click Paste Special. 

• If necessary, click Microsoft Office 

Excel Chart Object in the As list. 

Word displays the Paste Special dialog box 

(Figure 1-14). The Paste option button is 

selected. Microsoft Office Excel Chart 

Object is selected in the As list. 

FIGURE 1-14 

• Click the OK button. 

Word embeds the Bar chart into the 

document (Figure 1-15). 

FIGURE 1-15 

All Office 2003 applications allow you to use three methods to copy objects 

among applications: (1) copy and paste; (2) copy and embed; and (3) copy and link. 

The first method uses the Copy and Paste buttons. The latter two use the Paste 

Special command. Table 1-1 summarizes the differences among the three methods. 

Changing the Size of an Embedded Object 

The embedded Bar chart slightly exceeds the margins of the Leland Mortgage 

Home Page document. Reducing the size of the Bar chart will improve the layout of 

the document. In this project, you will use the Format Object dialog box to change 

the size of the chart. 
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2. Press CTRL+C 

3. In Voice Command mode 

say, “Copy” 

Other Ways 
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embedded in Word 

document table 

OK button 

Paste Special 
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Paste option 
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Microsoft Excel 

Chart Object 
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The following steps reduce the size of the chart using the Object command on 

the Format menu. 

To Change the Size of an Embedded Object 

• If necessary, click the Bar chart 

to select it. 

• Click Format on the menu bar. 

The Bar chart is selected as indicated 

by sizing handles on the selection 

rectangle. The Format menu is 

displayed (Figure 1-16). 

FIGURE 1-16 
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Copy and paste The source document becomes part of the destination document. An 

object may be edited, but the editing features are limited to those of 

the destination application. An Excel worksheet becomes a Word table. 

If changes are made to values in the Word table, any original Excel 

formulas are not recalculated. 

Copy and embed The source document becomes part of the destination document. An 

object may be edited in the destination document using source editing 

features. The Excel worksheet remains a worksheet in Word. If you 

make changes to values in the worksheet with Word active, Excel 

formulas will be recalculated. If you change the worksheet in Excel 

without the document open in Word, however, these changes will not 

display in the Word document the next time you open it. 

Copy and link The source document does not become part of the destination 

document, even though it appears to be. Instead, a link is established 

between the two documents, so that when you open the Word 

document, the worksheet displays within the document, as though it were 

a part of it. When you attempt to edit a linked worksheet in Word, the 

system activates Excel. If you change the worksheet in Excel, the changes 

also will display in the Word document the next time you open it. 

Table 1-1 Copy Methods 

Object 

command

Format 

menu 

Sizing 

handle 

Objects 

Objects can be nearly any 

part of an Office 2003 application 

or other Windows 

application. Some examples 

are Excel worksheets, a paragraph 

in a Word document, 

and a slide in a PowerPoint 

presentation. As long as you 

use the Paste Special command 

to paste data in the 

Clipboard, you can keep data 

in its native format. 

More About

• Click Object. 

• If necessary, click the Size tab. 

The Format Object dialog box with the Size 

sheet selected is displayed (Figure 1-17). 

FIGURE 1-17 

• In the Scale area, if necessary, 

click the Height box up or down 

arrow or the Width box up or 

down arrow until 90 % appears in 

both the Height box and the Width 

box. 

The Height box and the Width box both 

display 90 % (Figure 1-18). Depending on 

the size of the object when it was pasted 

into the Word document, you either may 

need to scale up or down in the Scale area 

Height and Width boxes. When you change 

the value in either the Height or Width box, 

both values change because the Lock 

aspect ratio check box is selected. 

• Click the OK button. 

• If necessary, scroll to see the 

embedded chart. 

Word reduces the size of the chart to 90% 

of its original size (Figure 1-19). 

FIGURE 1-19 
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FIGURE 1-18 

Microsoft Office 

Excel button on 

taskbar 

chart changed 

to 90% of its 

original size 

1. Right-click Bar chart, click 

Format Object on shortcut 

menu 

2. Select Bar chart, in Voice 

Command mode say, 

“Format Object” 

Other Ways

The Format Object dialog box (see Figure 1-17) contains two areas that can 

change the size of an object. The Size and rotate area allows you to increase or 

decrease the height or width of an object in inches. When available, it also allows 

you to rotate the object in degrees around an axis. The Scale area allows you to 

change the size of an object by a specific percentage while maintaining the heightto-

width ratio. The height-to-width ratio is referred to as aspect ratio. You change 

the height and width independently by deselecting the Lock aspect ratio check box. 

The Original size area at the bottom of the Format Object dialog box displays the 

original height and width of the selected object. 

Quitting Excel 

With the Bar chart embedded in the Word document, you no longer need the 

Leland Mortgage Product Types workbook open. The following steps quit Excel. 

To Quit Excel 

Right-click the Microsoft Office Excel - Leland Mortgage Product Types button 

on the taskbar. Click Close on the shortcut menu. If prompted to save 

changes, click the No button. 

If the Microsoft Excel dialog box displays regarding saving the large amount 

of information on the Clipboard, click the No button. 

Adding Scrolling Text to a Word Document 

The Word document is almost ready to be saved as a Web page. The final item that 

needs to be added is something that will capture the attention of your Web page visitors. 

One of the attention-grabbing techniques that Web developers use is scrolling 

text. Scrolling text is a line of text that moves across the Web page. Generally, 

scrolling text is used to highlight information about the Web site. With Word 2003, 

you can create scrolling text using the Scrolling Text button on the Web Tools toolbar. 

A scrolling marquee will be created just below the Leland Mortgage heading. 

To create scrolling text, the Web Tools toolbar must display. The steps on the 

next page display the Web Tools toolbar. 
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Q: What are some other 

methods to resize objects? 

A: To resize an image 

proportionally from a corner, 

you can press and hold down 

the SHIFT key while dragging a 

corner sizing handle. To resize 

vertically, horizontally, or 

diagonally from the center 

outward, press and hold 

down the CTRL key while 

dragging a sizing handle. To 

resize proportionally from 

the center outward, press and 

hold down the CTRL+SHIFT 

keys and drag a corner 

sizing handle. 

& Q A

To Display the Web Tools Toolbar 

• If necessary, scroll to see the top 

of the document. 

• Click View on the menu bar, point 

to Toolbars, and then click Web 

Tools on the Toolbars submenu. 

• If necessary, point to the Web 

Tools toolbar title bar and then 

drag the toolbar to the center, 

right side of the window. 

The Web Tools toolbar is displayed 

(Figure 1-20). 

FIGURE 1-20 

The Web Tools toolbar is used to create the scrolling text that moves below the 

Web page heading. 

Inserting Scrolling Text 

A number of options are available for scrolling text. The behavior of the text 

specifies the manner in which the text moves on the Web page. By default, the 

behavior of the line of text is to scroll. Scrolling moves the text in from one side and 

off the other side of the Web page. Another behavior option is to slide the text. Setting 

the behavior to slide moves the text in from one side of the Web page and stops 

as soon as the text touches the opposite side. The third option is to set text behavior 

to alternate. Alternate bounces the text back and forth in the margins of the marquee. 

The default behavior is scrolling text. In this project, the scrolling text behavior 

is changed to slide, as shown in the following steps. 
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Web Tools 

toolbar 

Scrolling 

Text button 

Scrolling Text 

To format the text, use the 

Font command on the Format 

menu while you are in Design 

mode. You turn off Design 

mode to see the results. In 

browsers that do not support 

scrolling text, the text will 

display but it will not be 

scrolling. 

More About

To Insert Scrolling Text into a Word Document 

• Click the paragraph mark below 

the Leland Mortgage heading and 

then click the Scrolling Text button 

on the Web Tools toolbar. 

Word displays the Scrolling Text dialog box 

(Figure 1-21). 

• Click the Behavior box arrow and 

then click Slide in the list. 

• Drag through the text, Scrolling 

Text, in the Type the scrolling text 

here text box. 

• Type Rates are beginning to 

rise! Act now to lock in a 

great rate! as the scrolling text. 

FIGURE 1-21 

• Drag the Speed slide one speed 

marker to the left and then click 

the OK button. 

The scrolling text is displayed (Figure 1-22). 

FIGURE 1-22 
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The direction of the text movement can be left to right or right to left. The 

direction attribute in the scrolling text options controls this movement. The default 

direction is to move right to left, so the text begins in the right margin of the line of 

scrolling text and moves to the left. 

The speed of the scrolling text also can be varied from slow to fast. Scrolling the 

text too fast cancels the benefits of the scrolling text. If the Web page visitor cannot 

read the text because it scrolls too fast, the text serves no purpose. 

Other options that can be controlled in scrolling text are background colors and 

the number of times to loop the scrolling text. The background attribute determines 

the color of the line of scrolling text. The background default is a transparent background, 

so the background of the line of scrolling text displays the background color 

of whatever is behind it. The loop attribute determines the number of times that the 

scrolling text moves across the Web page. The default is an infinite loop, which means 

the text will scroll indefinitely, but the loop can be set to a specific number of times. 

The scrolling text inserted into the Word document uses the default direction, 

background color, and loop. The behavior selected for the scrolling text is Slide. The 

Slide behavior causes the text to scroll from the right margin and stop scrolling when 

it reaches the left margin. The next section explains how to resize the scrolling text. 

Resizing the Scrolling Text 

The default for scrolling text is to move the text all the way across the Web 

page from the right margin of the page to the left margin. Sometimes, it is better to 

shorten the distance of the scrolling text. In this project, the scrolling text is centered 

below the Leland Mortgage heading and address of the Word document. The Web 

page visitor sees the company name with address and telephone number information 

below it, followed by the scrolling message. This project uses the Design mode to 

change the size of the scrolling text. In general, Design mode allows you to 

rearrange and design the page in a user-friendly manner. 

The following steps change the size of the scrolling text. 

To Resize the Scrolling Text 

• Click the Design Mode button on 

the Web Tools toolbar. 

• If necessary, click anywhere within 

the scrolling text box to select the 

text. 

• Point to the center sizing handle 

on the right side of the text box. 

The text box is displayed as shown in 

Figure 1-23. 

FIGURE 1-23 
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• Drag the center sizing handle to 

the left, so that it is positioned 

approximately as shown in 

Figure 1-24, but do not release 

the mouse button. 

The dotted line shows the proposed size for 

the scrolling text. 

FIGURE 1-24 

• Release the mouse button. 

The scrolling text box is resized 

(Figure 1-25). 

FIGURE 1-25 

The home page for the Leland Mortgage Web site is complete. 

Viewing the Word Document in Your Browser 

and Saving It as a Web Page 

The next step is to view the Word document in your browser to verify that all 

information is accurate. After verifying its accuracy, you then can save the Word 

document as an HTML file. Saving the Word document as an HTML file makes it 

possible for it to be viewed using a browser, such as Internet Explorer. 

The steps on the next page preview the document in the browser and then save 

the Word document as an HTML file. 
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Web Page 

Formatting 

Because Word provides 

formatting options that most 

Web browsers do not support, 

some text and graphics 

may look different when you 

view them on a Web page. 

When creating documents for 

the Web, using Web layout 

view will ensure that your 

graphics look the way you 

want them to when they are 

viewed as Web pages in a 

Web browser. 

More About

To Preview the Web Page 

• Click File on the menu 

bar and then click Web 

Page Preview. 

• If necessary, click the 

Maximize button on 

your browser’s title bar. 

The browser displays the 

Web page (Figure 1-26). 

• Click the browser’s 

Close button. 

FIGURE 1-26 

Verify that the Web page contains all information necessary and is displayed as 

shown in Figure 1-26. The Web page consists of a heading with images and the company 

name, address, and telephone number. Below that is a single line of scrolling 

text that scrolls in from the right margin and stops when it reaches the left margin. 

A borderless table displays three hyperlinks in the left column and a Bar chart in the 

right column. The E-mail for Information hyperlink should work appropriately when 

you click it, displaying a new message. The other two links, Application Process and 

Mortgage Products, do not work because the corresponding Web pages are not 

available until later in this project. 

If the Web page is correct, save it on the Integration Data Disk as an HTML 

file. If changes need to be made to the Web page, return to the Word document and 

correct it. The following steps save the document as a Web page. 

To Save a Document with a New File Name 

Click File on the menu bar and then click Save as Web Page. If the Microsoft 

Office Word dialog box displays, click the Continue button. 

Type LelandHome in the File name text box. 

Select Web Page in the Save as type box. 3
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1. Press ALT+F, press B 

2. In Voice Command mode 

say, “File, Web Page 

Preview” 

Other Ways

If necessary, click the Save in box arrow and then click 31/2 Floppy (A:) in the 

Save in list. 

Click the Save button in the Save As dialog box. If the Microsoft Office Word 

dialog box displays, click the Continue button. 

Word displays the LelandHome Web page in the Word window (Figure 1-27). 

FIGURE 1-27 

Saving an existing Word document as a Web page allows you quickly to get a 

Word document ready for copying to the Web or to an intranet. One alternative to 

this is to write the Hypertext Markup Language (HTML) to develop the Web pages. 

HTML is a programming language used for Web page creation. The home page 

created earlier in this project could be created by writing HTML tags (code). For 

documents that already are in Word format, the easier method is to use the Word 

Save as Web Page command. This essentially creates the HTML code for you and 

saves it in a file. The following step quits Word. 

To Quit Word 

Click the Close button on the Microsoft Word title bar. 

The next step in creating the Web site for Leland Mortgage is to save a 

PowerPoint presentation as an HTML file. The sections on the next pages describe 

how to open a PowerPoint presentation, add a hyperlink to the first page, and save 

the presentation as an HTML file. 
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Languages 

A number of programming 

languages can be used to create 

Web pages. Web pages 

created using the Save as 

Web Page command on the 

File menu can be enhanced 

with other Web programming 

languages, such as ASP, 

DHTML, and JavaScript. 

More About

Creating a PowerPoint Presentation Web Page 

PowerPoint is a powerful software tool often used to assist in the presentation of 

information to groups of people. PowerPoint 2003 allows you to create Web pages 

from an existing PowerPoint presentation, using the Save as Web Page command. 

The presentation then can be viewed using your browser. 

The PowerPoint presentation used in this project consists of three slides 

(Figure 1-1g on page INT 7). The first slide is a title slide, containing the company 

name and graphics. Slide 2 consists of information about the mortgage application 

process. Slide 3 includes information about what happens after a customer submits a 

mortgage application and the benefits of working with Leland Mortgage. This information 

can be used in its present format to enhance a presentation about the company. 

As Web pages, you can use this presentation to address a much wider, global 

audience on the World Wide Web. 

The following steps open an existing PowerPoint presentation. 

To Start PowerPoint, Customize PowerPoint, and Open 

an Existing Presentation 

Click the Start button on the Windows taskbar, point to All Programs on 

the Start menu, and then click Open Office Document on the All Programs 

submenu. 

Click the Look in box arrow and then click 31/2 Floppy (A:) in the Look in list. 

Double-click the Leland Mortgage Presentation name. 

If the Language bar is displayed, right-click it and then click Close the 

Language bar on the shortcut menu. 

If the Getting Started task pane appears in the PowerPoint window, click its 

Close button in the upper-right corner. 

If the Standard and Formatting toolbars are positioned on the same row, 

click the Toolbar Options button and then click Show Buttons on Two Rows. 

PowerPoint displays Slide 1 of the PowerPoint presentation (Figure 1-28). 

FIGURE 1-28 

The PowerPoint presentation now is open. The next step is to add a hyperlink on 

Slide 1 that allows the Web page visitor to return to the Leland Mortgage home page. 
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Adding Text for a Hyperlink 

One of the more important features of Web sites is their capability of linking from 

one Web page to another using hyperlinks. In earlier steps in this project, you added 

three hyperlinks to the Leland Mortgage home page. Once Web page visitors link to 

the PowerPoint Web pages, however, they cannot return to the home page without 

using the Back button on the browser’s toolbar. This is not a convenient way for Web 

page visitors to navigate through the Web site. In this section, you will add a Home 

link to the first slide of the PowerPoint presentation (Figure 1-1e on page INT 7). 

The following steps add the text that will be used as a hyperlink on the 

PowerPoint Web page. 

To Add Text for a Hyperlink into a PowerPoint Presentation 

Click the Text Box button on the Drawing toolbar. 

Click in the lower-right corner of Slide 1. 

Type Home as the hyperlink text. 

The text box is displayed with Home as the text for the hyperlink (Figure 1-29). 

FIGURE 1-29 

Creating a Hyperlink 

After you enter the text for the hyperlink, you can create the hyperlink itself. 

When clicked, the hyperlink jumps to the Leland Mortgage home page created previously 

in this project and saved on drive A. To create the hyperlink, you will use the 

Insert Hyperlink button on the Standard toolbar. 

The steps on the next page create the PowerPoint hyperlink. 
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font 
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Bold 

button 
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Keeping Links 

Fresh 

When you create a Web 

page, it is important to make 

sure that all of your hyperlinks 

are functional as time 

goes on. Links to other pages 

can become stale, or nonfunctional, 

if another Web 

page creator or an external 

site takes a page offline. 

Automated tools can help 

you identify when pages to 

which you are hyperlinking no 

longer are available. 

More About

To Insert a Hyperlink into a PowerPoint Presentation 

• Double-click the word, Home, 

inside the text box you just 

inserted. 

• If necessary, click the Font Size 

box arrow on the Formatting 

toolbar and then click 24. 

• Click the Bold button on the 

Formatting toolbar. 

• Click the Insert Hyperlink button 

on the Standard toolbar. 

• If necessary, click the Existing File 

or Web Page button on the Link 

to bar. 

• Type a:\LelandHome.htm in the 

Address text box. Click the OK 

button. 

Slide 1 of the presentation is displayed as 

shown in Figure 1-30. 

Viewing and Saving the PowerPoint Web Page 

Just as in the previous section of this project, the following steps display the Web 

page before saving it. It is important to verify all of the Web page navigation features 

before saving the file. 

To View the Web Page in Your Browser 

Click File on the menu bar. 

Click Web Page Preview. 

If necessary, click the Maximize button on your browser’s title bar. 

The browser displays the PowerPoint Web page (Figure 1-31). 
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FIGURE 1-30 

Insert Hyperlink 
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and hyperlink

FIGURE 1-31 

Slide 1 of the PowerPoint presentation Web page contains a hyperlink to the 

home page of the Leland Mortgage Web site. Although you created this hyperlink by 

adding a text box to the first slide, you also can create hyperlinks from existing text 

or images in a PowerPoint presentation. For example, one of the logo images on 

slide 1 could be used as a hyperlink to the home page of the Web site. Using one of 

those images, however, does not give the Web page visitor a clear idea of where the 

hyperlink will lead. It is more appropriate to create a hyperlink to the home page 

from text — for example, Home — that makes sense to the visitor. 

In addition to any hyperlinks that are added to the presentation, PowerPoint 

automatically creates hyperlinks in the left column of the Web page, called the 

outline. Using the Expand/Collapse Outline button below the outline pane, you 

can expand or collapse the outline and navigate through the Web page presentation 

(Figure 1-31). The text in the heading of each slide is used as the phrases for these 

hyperlinks. When you click a link, you jump to that particular slide within the presentation. 

The ease of navigation within a PowerPoint Web page is valuable to the 

Web page visitor. 

As well as being able to add your own hyperlink text, PowerPoint provides some 

ready-made action buttons that you can insert into your Web pages. Action buttons 

contain shapes, such as left and right arrows, that can be used to hyperlink to other 

Web pages within the presentation. You can insert symbols on the action buttons for 

going to the next (right arrow), previous (left arrow), first (beginning arrow), and 

last (end arrow) slides. PowerPoint also includes action buttons for playing movies 

or sounds. You insert these action buttons using the slide master feature of 

PowerPoint. 
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Q: Can I make my Web 

pages available on the World 

Wide Web? 

A: Yes. The Web pages 

created in this project all are 

stored locally on your computer. 

Typically, a Web page 

must be published to a server 

inside the organization or at 

your ISP. Microsoft offers a 

Web Page Publishing Wizard 

to assist in moving all of the 

related files and directories 

that comprise a Web Site. 

& Q A

Saving the PowerPoint Presentation as a Web Page 

The next step is to save the PowerPoint presentation as a Web page. When you save 

a PowerPoint presentation as a Web page, the Web page is saved in a default folder. 

All supporting files, such as backgrounds and images, are organized in this folder 

automatically. The name of the PowerPoint slide show opened in this section is 

Leland Mortgage Presentation. PowerPoint uses the name of the saved Web page 

and adds the string, files, for the name of the new folder. When the current presentation 

is saved as a Web page, the folder name that PowerPoint Web creates is 

ApplicationProcess files. The default name for the first slide in the presentation is 

frame.htm. The structure used in the folder organization makes Web page publishing 

easier because you can keep track of all of the files associated with the Web page. 

You also can edit the files manually, rather than using PowerPoint. 

The steps below save the PowerPoint presentation as a Web page. 

To Save the PowerPoint Presentation as a Web Page 

Click the Microsoft PowerPoint button on the taskbar. 

Click File on the menu bar and then click Save as Web Page. 

Type ApplicationProcess in the File name text box. 

Select Web Page in the Save as type box. 

If necessary, click the Save in box arrow and then click 31/2 Floppy (A:) in the 

Save in list. 

Click the Save button in the Save As dialog box. 

The PowerPoint presentation is saved as a Web page. 

The task of saving the PowerPoint presentation as a Web page is complete. The 

hyperlink has been added to Slide 1 of the presentation that jumps to the Web site 

home page when clicked. Standard Web page navigation was added automatically to 

the presentation that allows the Web page visitor to jump to any slide in the Web 

page presentation. All of the files necessary for the Web page were saved in a folder 

named ApplicationProcess_files. 

After saving the PowerPoint presentation as a Web page, you can quit 

PowerPoint and close your browser as shown in the following steps. 

To Quit PowerPoint and Close Your Browser 

Click the Close button on the PowerPoint title bar. 

Click the Close button on the browser title bar. 

Creating a Data Access Page from an Access 

Database 

The next step in the Leland Mortgage Web site creation is to use an Access database 

to create a data access page. A data access page is a special type of Web page that is 

designed for viewing and working with data. Similar to a form, a data access page is 

connected, or bound, directly to an Access database. 
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displayed by default when you 

view a presentation in a 

browser. To hide this pane, 

click the Outline button while 

in the browser. Click the 

Outline button again to redisplay 

the outline pane. 

& Q A

You can use data access pages to analyze data, enter and edit data, make 

projections, and review data. In addition, you can create a chart using the chart component 

to analyze trends, show patterns, and make comparisons on the data in the 

database. Then, you can add spreadsheet controls to allow the inclusion of formulas 

for calculations. 

One of the more common purposes of data access pages is for viewing records in 

a database via a company’s intranet or the World Wide Web. Data access pages provide 

a method to make inquiries of large amounts of data in a selective way. Groups 

of records can be expanded or collapsed so that Web page visitors can view the data 

they want to see. 

The following steps open an Access database. 

To Start Access and Open an Existing Database 

Click the Start button on the Windows taskbar, point to All Programs on 

the Start menu, and then click Open Office Document on the All Programs 

submenu. 

If necessary, click the Look in box arrow and then click 31/2 Floppy (A:) in the 

Look in list. 

Double-click the Leland Mortgage Products database name. If the Microsoft 

Office Access dialog box appears, click the Yes button. 

If the Language bar is displayed, right-click it and then click Close the 

Language bar on the shortcut menu. 

If the Getting Started task pane appears in the Access window, click its Close 

button in the upper-right corner. 

Access starts and opens the Leland Mortgage Products : Database window (Figure 1-32). 

FIGURE 1-32 

5

4

3

2

1 

Creating a Data Access Page from an Access Database • INT 31 

Integration Pro ject 1 

Objects 

bar 

Leland Mortgage 

Products Database 

window 

Pages 

object 

Viewing Web 

Pages 

In addition to Microsoft 

Windows environments, many 

environments exist for viewing 

Web pages. When creating 

a Web page with special 

features, such as data access 

pages, it is important to make 

sure that the special features 

are supported within the 

environment in which the 

Web page viewers operate. 

For example, users who view 

Web pages on Apple Macintosh 

computers may have a 

different Web page viewing 

experience. 

More About

Creating a Data Access Page Using the Page Wizard 

For the Leland Mortgage Web site, you do not want the database to be altered 

by the Web page visitor in any way. The visitors should be allowed to view only the 

data. Because of this, you must add a grouping level to the data access page. Adding 

grouping levels results in a read-only page. The Web page visitors can view all data 

and alter that view, but they cannot change the data itself. 

The following steps use the Page Wizard to create a data access page. 

To Create a Data Access Page Using the Page Wizard 

• Click the Pages object on the 

Objects bar. 

• Double-click Create data access 

page by using wizard. 

Access displays the Page Wizard dialog box 

that includes options for setting up data 

access pages (Figure 1-33). The Mortgage 

Products table is selected automatically 

because it is the only table in the database. 

If more than one table exists, you would need 

to click the Tables object on the Objects bar 

and then select the appropriate table 

before clicking the Pages object in Step 1. 

FIGURE 1-33 

• Click the Add All Fields button to 

add all the fields. 

The Selected Fields list displays all the fields 

in the table (Figure 1-34). This means you 

want to display all the fields on the data 

access page. 

FIGURE 1-34 
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• Click the Next button. 

• Double-click Category in the box 

on the left. 

Adding a grouping level, such as Category, 

prohibits the data access page from being 

updated. Category is displayed in the upperright 

box indicating it has been selected 

(Figure 1-35). 

FIGURE 1-35 

• Click the Next button. 

The Page Wizard dialog box displays 

options for sorting records (Figure 1-36). No 

changes are required. 

FIGURE 1-36 
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• Click the Next button and then, 

if necessary, type Mortgage 

Products in the What title do you 

want for your page? text box. 

• If necessary, click Modify the 

page’s design to select it. 

The Page Wizard dialog box displays the 

page title, Mortgage Products, in the text 

box and the Modify the page’s design 

option button selected (Figure 1-37). 

FIGURE 1-37 

• Click the Finish button. 

• If necessary, close the Field List 

task pane. 

Access displays the data access page in 

Design view (Figure 1-38). 

FIGURE 1-38 

Adding a Title and Resizing a Label on a Data Access Page 

The data access page is created, but additional information can be helpful for the 

Web page visitor. It is customary to insert a title at the top of the page that tells the 

visitor the purpose of the Web page. Resizing the Current Interest Rate label and the 

Last Week’s Interest Rate label is necessary because the entire text of these labels 

does not show after completing the Data Access Page Wizard. The following steps 

add a title and resize two labels. 
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To Add a Title and Resize Labels on a Data Access Page 

• If necessary, scroll to the top of 

the data access page. 

• With the data access page in 

Design view, click anywhere in the 

Click here and type title text entry 

area. 

• Type Leland Mortgage Products 

as the title. 

Access displays the data access page as 

shown in Figure 1-39. 

• Click anywhere within the Current 

Interest Rate label in the Mortgage 

Products area of the data access 

page to select the label. 

• Point to the lower-right sizing 

handle on the label. 

• Drag the resize handle straight 

down so that it doubles in height. 

• Click anywhere within the Last 

Week’s Interest Rate label in the 

Mortgage Products area of the data 

access page to select the label. 

• Point to the lower-right 

sizing handle on the label. 

• Drag the resize handle straight 

down so that it doubles in 

height. 

The Current Interest Rate label 

and the Last Week’s Interest Rate label are 

resized, and Access displays the data 

access page as shown in Figure 1-40. 
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FIGURE 1-40 

FIGURE 1-39

The data access page is created, a heading is positioned in the header, and the 

label is resized as shown in Figure 1-1d on page INT 6. The next step is to add a 

hyperlink that returns the visitor to the Web site home page. 

Adding a Hyperlink to a Data Access Page 

Just as you did on the PowerPoint Web page, you should add a hyperlink on the 

data access page that links to the home page. This allows the Web page visitor to return 

to the Leland Mortgage home page without having to click the Back button on the 

browser’s toolbar repeatedly. The following steps add a hyperlink to the data access page. 

To Add a Hyperlink to a Data Access Page 

• If necessary, click View on the 

menu bar and then click Toolbox to 

display the Toolbox. Scroll down so 

the bottom of the data access page 

displays. 

• Click the Hyperlink button on the 

Toolbox and then point below the 

design grid. 

The hyperlink mouse pointer is 

displayed as shown in 

Figure 1-41. 

FIGURE 1-41 

• Click below the Design grid. 

The Insert Hyperlink dialog box 

is displayed (Figure 1-42). 

FIGURE 1-42 
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• If necessary, click the Existing File 

or Web Page button on the Link to 

bar. 

• Type Home in the Text to display 

text box. 

• Type LelandHome.htm in the 

Address text box and then click the 

OK button. 

• If the Microsoft Office Access 

dialog box appears, click the OK 

button. 

• Click anywhere on the data access 

page to deselect the hyperlink box. 

Access displays the data access page as 

shown in Figure 1-43. 

The data access page is complete. In the next section, you will save the page to 

the Integration Data Disk and view it in the browser. 

Saving the Data Access Page and Viewing It 

In other sections of this project, you have viewed the Web page, verified that it is 

correct, and then saved it on a floppy disk. Unlike Word and PowerPoint, you must 

save a data access page before you can preview it in your browser. As the Web page 

is being opened in your browser, Access displays a Databinding message on the status 

bar of your browser. This indicates that the data access page is connecting to the 

database that was open when the page was created (Leland Mortgage Products). 

The following steps save the file on the Integration Data Disk and then open it 

for viewing in the browser. 

To Save the Data Access Page and View It in Your Browser 

Click File on the menu bar and then click Web Page Preview. When the 

Microsoft Office Access dialog box displays, click the Yes button. 

When the Save As Data Access Page dialog box displays, if necessary, type 

MortgageProducts in the File name text box. If necessary, click 31/2 Floppy 

(A:) in the Save in list. 

Click the Save button in the Save As Data Access Page dialog box. 

Click the Expand indicator to the left of the Category label to expand the 

display. 

The browser displays the expanded data access page (Figure 1-44 on the next page). 
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hyperlink 

inserted 

1. Right-click below design 

grid, in Voice Command 

mode say, “Hyperlink” 

Other Ways 

Database 

Connections 

When a Web page tries to 

obtain data from a database, 

such as Access 2003, you 

must be sure that the database 

is accessible to the Web 

page. When publishing Web 

pages that include data access 

pages, you should check with 

your system administrator to 

make sure that the Web page 

will have the proper access to 

the database. 

More About 

FIGURE 1-43

FIGURE 1-44 

After you save the data access page, you can preview it and then quit Access and 

close your browser, as shown in the following steps. 

To Close Your Browser and Quit Access 

Right-click the Leland Mortgage Products button on the taskbar and then 

click Close on the shortcut menu. 

Click the Close button on the Access title bar to quit Access. 

Grouping records on a data access page is similar to grouping records on a 

report. You can group the data on this data access page in different ways, but the 

user cannot edit the data. The records in the data access page can be expanded or 

collapsed, using the Expand and Collapse indicators. This allows users to customize 

their view of the data and remove extra data from view that may not interest them. 

Using the navigation toolbars on the data access page, you can move, sort, and filter 

records and obtain Help. 

Use the navigation toolbar to verify that the information in the database displays 

correctly. Click the link to the home page of the Web site to verify it. 

Testing the Web Site 

The Leland Mortgage Web site is complete. To ensure that all the links in the Web 

site are viable, the following steps open the home page and then thoroughly test the 

entire Web site. 

To Test the Web Site 

Start your browser. 

Click the Address bar of your browser. 2
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Microsoft 

Certification 

The Microsoft Office 

Specialist Certification program 

provides an opportunity 

for you to obtain a valuable 

industry credential – proof 

that you have the Office 2003 

skills required by employers. 

For more information, see 

Appendix E, or visit the 

Office Integration 2003 

Certification Web page 

(scsite.com/int2003/cert). 

More About

FIGURE 1-45 

Verifying the Hyperlinks in Your Browser 

All hyperlinks should be tested by clicking them and verifying that they jump to 

the correct Web page. Three hyperlinks are on the home page: Application Process, 

Mortgage Products, and E-mail for Information. The following steps test the links. 

To Verify the Hyperlinks 

Click the Application Process hyperlink. 

Click the navigation buttons to view all slides on the Web page. 

On the first slide on the PowerPoint Web page, click the Home hyperlink. 

Click the Mortgage Products hyperlink. Click the Expand and Collapse 

indicators and then scroll through the database using the navigation 

toolbars. 

On the data access page, click the Home hyperlink. 

Click the E-mail for Information hyperlink. 

A new e-mail message displays with manager@isp.com in the To text box. 

With the hyperlinks verified, the steps on the next page quit the e-mail program 

and the browser. 
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Type a:\LelandHome.htm in the text box, and then press the ENTER key. 

The browser displays the home page of the Leland Mortgage Web site as shown in Figure 1-45. 

3 

Web Discussions 

The Web Discussions feature 

enables you and other people 

to insert remarks into a Web 

page. The discussions are 

threaded; that is, replies to a 

discussion remark are nested 

directly below it. You can 

have multiple discussions in 

progress simultaneously. You 

start a discussion from within 

your browser. The Web Discussions 

feature is available 

only with Microsoft Office 

Server Extensions, a feature 

that is set up by a system 

administrator on a server. 

Learn more about discussions 

in Word 2003 Help. 

More About

To Quit E-Mail and Close Your Browser 

Click the Close button on your e-mail program. 

Click the Close button on your browser’s title bar. 

Project Summary 

This project introduced you to integrating Microsoft Office 2003 applications. You opened an existing Word 

document and created a two-column, one-row, borderless table. You then inserted three hyperlinks, embedded a Bar 

chart from an existing Excel worksheet, and saved that document as an HTML file. You then opened an existing 

PowerPoint presentation, added a hyperlink to the first slide, and saved this presentation as a Web page. Finally, you 

opened an existing Access database and used the Page Wizard to create a data access page. You created a grouping 

level so the database could not be changed. You saved that data access page and viewed and tested all Web pages 

and hyperlinks. 

What You Should Know 

Having completed this project, you should be able to perform the tasks below. The tasks are listed in the same 

order they were presented in this project. For a list of the buttons, menus, toolbars, and commands introduced in 

this project, see the Quick Reference Summary at the back of this book and refer to the Page Number column. 
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1. Start Word, Customize Word, Open an Existing 

Document, and Save the Document with Another 

Name (INT 8) 

2. Insert a Table into a Word Document (INT 9) 

3. Remove the Table Border (INT 11) 

4. Insert Text for Hyperlinks (INT 12) 

5. Create a Hyperlink to PowerPoint Web Pages 

(INT 13) 

6. Insert the Remaining Hyperlinks (INT 13) 

7. Start Excel, Customize Excel, and Open an Existing 

Workbook (INT 14) 

8. Embed an Excel Chart into a Word Document 

(INT 15) 

9. Change the Size of an Embedded Object 

(INT 17) 

10. Quit Excel (INT 19) 

11. Display the Web Tools Toolbar (INT 20) 

12. Insert Scrolling Text into a Word Document 

(INT 21) 

13. Resize the Scrolling Text (INT 22) 

14. Preview the Web Page (INT 24) 

15. Save a Document with a New File Name 

(INT 24) 

16. Quit Word (INT 25) 

17. Start PowerPoint, Customize PowerPoint, and 

Open an Existing Presentation (INT 26) 

18. Add Text for a Hyperlink into a PowerPoint 

Presentation (INT 27) 

19. Insert a Hyperlink into a PowerPoint 

Presentation (INT 28) 

20. View the Web Page in Your Browser (INT 28) 

21. Save the PowerPoint Presentation as a Web Page 

(INT 30) 

22. Quit PowerPoint and Close Your Browser 

(INT 30) 

23. Start Access and Open an Existing Database 

(INT 31) 

24. Create a Data Access Page Using the Page Wizard 

(INT 32) 

25. Add a Title and Resize Labels on a Data Access 

Page (INT 35) 

26. Add a Hyperlink to a Data Access Page 

(INT 36) 

27. Save the Data Access Page and View It in Your 

Browser (INT 37) 

28. Close Your Browser and Quit Access (INT 38) 

29. Test the Web Site (INT 38) 

30. Verify the Hyperlinks (INT 39) 

31. Quit E-Mail and Close Your Browser (INT 40)

Instructions: To complete the Learn It Online exercises, start your browser, click the Address bar, and then 

enter the Web address scsite.com/int2003/learn. When the Office 2003 Learn It Online page is displayed, 

follow the instructions in the exercises below. Each exercise has instructions for printing your results, either for 

your own records or for submission to your instructor. 

Project 

Reinforcement 

TF, MC, and SA 

Below Office Integration 

Project 1, click the Project 

Reinforcement link. Print the 

quiz by clicking Print on the 

File menu for each page. 

Answer each question. 

Flash Cards 

Below Office Integration 

Project 1, click the Flash Cards 

link and read the instructions. 

Type 20 (or a number specified 

by your instructor) in the 

Number of playing cards text 

box, type your name in the 

Enter your Name text box, 

and then click the Flip Card 

button. When the flash card is 

displayed, read the question 

and then click the ANSWER 

box arrow to select an answer. 

Flip through Flash Cards. If 

your score is 15 (75%) correct 

or greater, click Print on the 

File menu to print your 

results. If your score is less 

than 15 (75%) correct, then 

redo this exercise by clicking 

the Replay button. 

Practice Test 

Below Office Integration 

Project 1, click the Practice 

Test link. Answer each question, 

enter your first and last 

name at the bottom of the 

page, and then click the Grade 

Test button. When the graded 

practice test is displayed on 

your screen, click Print on the 

File menu to print a hard 

copy. Continue to take practice 

tests until you score 80% 

or better. 

Who Wants To 

Be a Computer 

Genius? 

Below Office Integration 

Project 1, click the Computer 

Genius link. Read the instructions, 

enter your first and last 

name at the bottom of the 

page, and then click the PLAY 

button. When your score is 

displayed, click the PRINT 

RESULTS link to print a hard 

copy. 

Wheel of Terms 

Below Office Integration 

Project 1, click the Wheel of 

Terms link. Read the instructions, 

and then enter your first 

and last name and your 

school name. Click the PLAY 

button. When your score is 

displayed, right-click the score 

and then click Print on the 

shortcut menu to print a hard 

copy. 

Crossword 

Puzzle Challenge 

Below Office Integration 

Project 1, click the Crossword 

Puzzle Challenge link. Read 

the instructions, and then 

enter your first and last name. 

Click the SUBMIT button. 

Work the crossword puzzle. 

When you are finished, click 

the Submit button. When the 

crossword puzzle is redisplayed, 

click the Print Puzzle 

button to print a hard copy. 

Tips and Tricks 

Below Office Integration 

Project 1, click the Tips and 

Tricks link. Click a topic that 

pertains to Project 1. Rightclick 

the information and then 

click Print on the shortcut 

menu. Construct a brief example 

of what the information 

relates to in Office Integration 

to confirm you understand 

how to use the tip or trick. 

Newsgroups 

Below Office Integration 

Project 1, click the 

Newsgroups link. Click 

a topic that pertains to 

Project 1. Print three 

comments. 

Expanding Your 

Horizons 

Below Office Integration 

Project 1, click the Expanding 

Your Horizons link. Click 

a topic that pertains to 

Project 1. Print the information. 

Construct a brief example of 

what the information relates to 

in Office Integration to confirm 

you understand the contents of 

the article. 

Search Sleuth 

Below Office Integration 

Project 1, click the Search 

Sleuth link. To search for a 

term that pertains to this project, 

select a term below the 

Project 1 title and then use the 

Google search engine at 

google.com (or any major 

search engine) to display and 

print two Web pages that 

present information on the 

term. 

Office 

Integration 

Online Training 

Below Office Integration 

Project 1, click the Office 

Integration Online Training 

link. When your browser displays 

the Microsoft Office 

Online Web page, click the 

Office Integration link. Click 

one of the Office Integration 

courses that covers one or 

more of the objectives listed at 

the beginning of the project 

on page INT 4. Print the first 

page of the course before 

stepping through it. 

Office 

Marketplace 

Below Office Integration 

Project 1, click the Office 

Marketplace link. When your 

browser displays the 

Microsoft Office Online Web 

page, click the Office Marketplace 

link. Click a topic that 

relates to Office Integration. 

Print the first page. 
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1 Creating a Web Page in Word with an Embedded Excel Chart 

Problem: As vice president of Molero Home Builders, you have created a worksheet and chart in Excel to 

analyze the sales for the past year. Create a Web page in Word and embed the chart from the Molero Home 

Builders workbook on the home page. Add a link to a second Web page and an e-mail link to molero@isp.com 

below the chart. Create a second Web page in Word by embedding the Molero Home Builders worksheet. 

Instructions: Perform the following tasks. 

1. Start Excel by opening the Lab 1-1 Molero Home Builders workbook. 

2. Start Word and create a new Web page. Add a title as shown in Figure 1-46. Select the Molero Home 

Builders chart in Excel, copy it, and use the Paste Special dialog box in Word to embed the Excel Chart 

Object. Resize the chart to 84% of its original size. 

FIGURE 1-46 
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3. Add two hyperlinks to the bottom of the page in a centered, borderless table. The first hyperlink should 

jump to the Web page MoleroSales.htm, which is created next. The second hyperlink creates an e-mail 

message to molero@isp.com. 

4. Save this file as Molero.htm. 

5. Create a new Web page in Word. 

6. Embed the Excel worksheet into the Word page. That is, switch to Excel, select the worksheet, copy the 

worksheet to the Clipboard, switch to Word, and use the Paste Special command on the Edit menu in Word 

to embed the Excel Worksheet Object. 

7. Save this file as MoleroSales.htm. 

8. View the Molero.htm file in your browser (Figure 1-46). Print the Web page. Click the Annual Sales link to 

navigate to the MoleroSales.htm page (Figure 1-47) and print it. 

FIGURE 1-47 
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2 Mirage Rental Web Site with a Data Access Page and an Excel Worksheet 

Problem: As the assistant manager of Mirage Rental, Tammie Glover is responsible for keeping track of large 

equipment that is rented on a per-day basis. She would like you to design a site that allows customers to view 

the availability of equipment for rent. She also wants an e-mail link for questions. 

Instructions: Perform the following tasks. 

1. Start Word. Create a home page for the Mirage Rental for Large Equipment Web site (Figure 1-48). Add a title 

and a borderless table below the title. In the left column, insert three hyperlinks. The first hyperlink should 

go to LargeEquipment.htm (Figure 1-49). The second hyperlink should go to EquipmentAvailability.htm 

(Figure 1-50). The third hyperlink should start an e-mail message to assistantmanager@isp.com. Type the 

text in the right column. Save the Web page as MirageLargeEquipment.htm. 

FIGURE 1-48 

FIGURE 1-49 
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2. Start Access by opening the Lab 1-2 LargeEquipment.mdb database on the Integration Data Disk. Create a 

data access page from the LargeEquipment table. Create a grouping level using the EquipmentType field. 

Add a title as shown in Figure 1-49. Add a link named Home that links to the MirageLargeEquipment.htm 

home page at the bottom of the data access page. Save the data access page as LargeEquipment.htm. 

3. Start Excel by opening the Lab 1-2 EquipmentAvailability.xls workbook on the Integration Data Disk. 

Create a Web page from the workbook by using the Save as a Web Page command on the File menu. Use 

the file name, EquipmentAvailability.htm. 

4. View the MirageLargeEquipment.htm Web page in your browser. Verify that all links operate properly by 

clicking each one. Print all Web pages. 

FIGURE 1-50 

3 GreensAndTrails Association Information Web Site Incorporating 

PowerPoint Web Pages 

Problem: As a volunteer with the GreensAndTrails Housing Association, you have offered to create a Web 

page that recruits residents to become board members of the association (Figures 1-51 and 1-52 on the next 

page). The specific information for the memberships is located in a PowerPoint presentation, which has four 

pages. 

Instructions: Perform the following tasks. 

1. Start Word. Create the Web page as shown in Figure 1-51. Include scrolling text below the Web page title. 

Insert two hyperlinks. The first hyperlink should link to GreensAndTrails.htm, and the second should link 

to an e-mail address at association@isp.com. Use clip art to insert the picture of a tree. Save this Web page 

as GATBoardRecruiting.htm. 

(continued) 
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GreensAndTrails Association Information Web Site Incorporating 

PowerPoint Web Pages (continued) 

FIGURE 1-51 

2. Open the Lab 1-3 PowerPoint presentation GreensAndTrails.ppt. Add a link named Home at the bottom of 

the first page of the presentation that jumps to the GATBoardRecruiting.htm Web page. Save the PowerPoint 

presentation as Web pages on the Integration Data Disk. Name the Web pages GreensAndTrails.htm. 

3. View the Web pages in your browser. Print each page. 

FIGURE 1-52 
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The difficulty of these case studies varies: 

are the least difficult and are the most difficult. The last exercise is a group exercise. 

1 You are working for a new ISP that offers wireless Internet access to local homes and businesses. 

The company offers three levels of service. The business plan has a startup fee of $100, a monthly 

charge of $75, and offers the highest speed and instant access to customer service. The residential plan 

has a startup fee of $50, a monthly charge of $40, and offers high speed, but with a limited amount of 

data that can be downloaded per day. The economy plan has a startup fee of $50, a monthly charge of 

$20, and offers a low-speed connection. Create a worksheet in Excel that summarizes each of these 

plans. Create a Web page using Word that embeds the Excel worksheet; the goal of the Web site is to 

inform new customers of the services provided. Make sure to include an e-mail address on the Web 

page. 

2 A local real-estate agent wants to advertise the child-friendly atmosphere of the area and has asked 

you for help. Research summer-time activities for area children under the age of 12 available from various 

groups and agencies in your area, and determine the following for each: organization name, program 

or activity name, number of weeks, contact name, contact telephone number, age range, and cost. 

Create an Excel worksheet and charts summarizing your data and graphing the age range and costs. 

Using Word, create a Web page and embed the worksheet on the home page of the Web site. Create 

another Web page, and embed the charts from Excel. Create a link to the Excel chart Web page and a 

link to each organization’s Web page. 

3 You have started making extra money by selling some personal items on an online auction Web 

site. As the number of items you sell grows, you want to advertise your current items on your own Web 

site. Create an Access database and add ten items to it with the following information for each item: item 

name, category, description, condition, and sale price. From this table, create a data access page with 

inquiry capability only, using the category as the grouping level. Include item name, category, description, 

condition, and sale price in the data access page. Use a search engine to find relevant links about 

each category of items — such as sports memorabilia, comic books, and old coins — and create links to 

one Web page each for each category at the bottom of the data access page. 

4 As a member of your school’s Career Day organization team, you have been asked to create a Web 

page on which students can view information about speakers at this year’s Career Day event. Create an 

Access database and add information about prospective speakers to the database. Include the following 

fields: name, area of expertise, job title, number of years in the field, and whether the person has spoken 

at Career Day in the past. From this table, create a data access page with inquiry capability only, 

using the area of expertise as the grouping level. Create a Web page using Word that will act as the 

Web page for the speaker list and create a link to the data access page. Be sure to include a link to your 

e-mail address on the Web page.
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5 Working Together Gather basic statistical data about the town or city in which you live, 

including population, important business and industry, and other demographic data. Have one member 

of your team create an Excel 3-D Bar chart to summarize the demographic information that you find. 

Have another member create a PowerPoint presentation that contains at least four major points regarding 

the town or city that may make the area interesting to outside businesses. A third member should create 

a data access Web page that includes information about local colleges. Embed the Excel chart into one 

of the PowerPoint slides. Create a link from one of the PowerPoint pages to the data access Web page. 

Save the PowerPoint presentation as Web pages. Include relevant links to Web pages regarding the area.

